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Bulk Rename Utility is a simple utility which allows you to rename multiple
files and folders, based upon flexible criteria. For example, you can add a prefix
or suffix to a file, or you can change three letters with four other letters in a
filename. There are lots of ways to manipulate file and folder names.

New users - please see the Getting Started page.
The application supports flexible renaming criteria, including:
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Select files and/or folders
Files and/or Folders
Full support for Perl-5 Regular Expressions
Change the file name, or use a fixed filename
Convert the extension to lower case, upper case, title case - or replace it - or
add a secondary extension - or remove it - or leave it alone!
Replace text with other text
Add a fixed prefix or suffix
Add text to the middle of a name
Move text to the start/end/middle of a name
Remove the first n characters
Remove the last n characters
Remove from the nth character to the nth character
Remove a list of characters
Remove all digits, characters or symbols
Remove double-spaces
Crop text before or after a fixed character or text (or from anywhere in a
name using a wildcard)
Change to upper case, lower case, title case, sentence case - all with userdefined exceptions
Auto-number files, with a prefix or suffix, and with a predefined minimumlength if required.

· Prefix or suffix the filename with various dates (date-modified, accessed,
created, or today's date), in many different formats with variable separators
·
·
·
·

Append the folder name to the file (with multiple levels)
Store your frequently-used criteria as Favourites
Copy or move the renamed files to a new location
Set or clear attributes on the files (not folders)

·
·
·
·

Rename files according to a delimited list.
Access the Shell Context Menu for all files/folders
Process folders and sub-folders very quickly.
Change a file or folder's Created, Modified and Accessed timestamps (not
folders in Windows 98)
Convert Roman Numerals to upper or lower case
Log all activity to a text-file
Create an UNDO batch file.
Extract certain EXIF tags from JPEG, TIFF, .NEF, .CR2 and and .CRW files
Extract certain ID3 tags (V1 and V1.1) from MP3 files
Drag files directly from within Windows Explorer

·
·
·
·
·
·

All of these changes automatically ignore the filename extension, as it's usually
dangerous to change the extension for a file. However, you can change the
extension case to a fixed extension, or add a "secondary" extension, and you can
also remove an extension. You can choose to ignore extensions within folder
names - e.g. treat Program.Files as a normal filename - but not filenames.
The application supports Favourites, which allows quick access to frequentlyused rename configurations.
Directory recursion is also fully supported, allowing you to process folders and
sub-folders.
If you like the application, but have some suggestions for enhancements or
improvements, then please get in touch. If you don't like the application then
please tell us what you don't like!

This help file is accurate as of version 2.7.1.0 (or later) of the Utility.

Getting Started
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Many users look at the screen and say "what do I do here?"! But Bulk Rename
Utility is really very straightforward to use.
There are four simple golden rules to follows:
1. Only complete the boxes you are interested in, For example, don't assume
you have to put something in the Regular Expressions box, or the New
Location box, etc.
2. You have to select files before the Rename button is enabled.
3. The "new name" will always be shown in the list, so you can experiment
until you get the desired result before actually committing the changes.
4. Almost all the boxes on the screen are ONLY for affecting the filename,
NOT the extension. The ONLY box which affects the extension is Box 11.
So for example, if you just want to change the filename case to upper case, all
you need to do is:
1. Change the dropdown in Box 4 to "Upper case".
2. Select the files you want to rename (Click the files, Shift+click to select a
range, Ctrl+click, Ctrl-A etc.)
3. Press the rename button.
And that's it! No worrying about regular expressions, new folders, autonumbers, dates etc. You only need to use the boxes you are interested in. Don't
want to move the files to a new folder? Then leave the New Location fields
blank. Don't want to change the filename case? Then leave the Case fields as
their default values.
It really is very simple. Remember - only use the boxes you are interested in.

About Bulk Rename Utility
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The Bulk Rename Utility was written by Jim Willsher using Visual C++.
Very special thanks go to Paolo Messina. Paolo provided the source code which
makes it easy to create "resizeable" dialogues in MFC, and he also provided the
functionality for the "tree" navigator on the left hand side of the utility. But over
and above that, Paolo made enhancements to my code and fixed the bugs that I
couldn't find. If it wasn't for Paolo then this utility might still be a Visual Basic
application!
Thanks also go to Jeff, Nigel, Bill Pratt, David A., Frans, Chris, Neil, Zaine,
Karl, Stefan and many others for their excellent suggestions, and testing of new
functionality, in the Visual Basic and C++ versions. An application is nothing
without input from its users.
Much of the help-file content was provided by Dave Williams. Dave is a user of
the utility, so recognises what a user likes to see in a help file. I wrote the
software so I know what every function does - but much of it might be
completely alien to a new user, which is exactly why Dave's input was so
useful!
Neil has provided some excellent feedback, both for bug-fixes and for new
suggestions.
The logic for the Tip Of The Day was based upon existing work by Robert
Pittenger.
The logic for the Splitter Window was based upon existing work by Maq.
The Regular Expression logic uses the excellent PCRE Library available here.
The EXIF tag extractor is by Davide Pizzolato, based on jhead by Matthias
Wandel.
The new icon was very kindly created and supplied by Christoph Mayar.
If you have any comments or suggestions about the application, or find any
errors in the application, then please get in touch. The latest version of the

application can always be downloaded from the website - many mirror sites are
out of date, so always use the latest version if you can.
The application website is www.bulkrenameutility.co.uk
Application updates are available from www.bulkrenameutility.co.uk.
Alternatively, just click here to visit the application's homepage. You can also
use the Check For Updates menu option on the Help menu - this requires an
internet connection.

Launching the application
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When you run the application for the very first time you will be presented with
the main window, located in the centre of the screen. This will only happen the
first time  subsequent launches will position the window wherever you left it.
This is true of all windows  the position of the window is retained between
sessions.
In addition, whenever you re-launch the application most of the settings from
your previous session will be retained, such as the directory and file-filter you
were using. For this to work you must save a Favourites file, even if it's just a
dummy file called "BRU Default Settings" or similar. If this sounds confusing
then just press Ctrl+S, enter a name (any name) and pres Enter!
Only one instance of the application may be launched. If you try to run the
application, and there is already a version running, then the original instance
will be displayed.
If you chose the Complete installation option then the easiest way to access the
Bulk Rename Utility dialog is from Windows Explorer itself. Simply highlight
the folder or folder containing files which you wish to rename, and then either
right-click or press shift Function Key 10 and select "Bulk Rename" from the
context menu. (NB This option doesn't apply to UNC drives, e.g. shares in
Network Neighbourhood, unless you have a drive letter mapped to that share).
Also, if you've previously saved a Favourite then you can double-click that
favourite to launch the application.
For an overview of the main screen layout, click here.
The first time you launch the Utility you will see a Tip Of The Day screen. You
can view the tips, and you can prevent them from showing again. To see Tips
manually, just choose the menu option.
Your preferences (except the screen layout) will be stored in a .INI file in the
same folder as the executable program. Whilst this goes against Microsoft's
philosophy, INI files are actually much better than the registry! You can take
your folder with you and use it on any system, knowing that it's already
configured for you! If you need two sets of preferences then create two copies
of the executable with different names, and you'll get two INI files.

Renaming Files and Folders
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It is really easy to rename files and folders. (For an overview of the main screen
layout, and guidance on the various controls, click here.)
1. Select the folder which contains the objects you wish to rename. If required,
you may also specify a file filter to restrict your list.
2. Enter the renaming criteria. The column beside the filename will show you
what the new filename will become.
3. Select the files you wish to process (use CTRL or SHIFT to select multiple
files).
4. Hit the Rename button. (This button is not enabled unless you have selected
one or more files/folders to rename!)
Note that, to select a folder to process, you can either:
· Use the tree to navigate to the folder
· Right-click a folder in Windows Explorer and choose Bulk Rename
· Press Ctrl-J to jump to a folder
· Press Ctrl-U to jump to the parent folder (e.g. the next folder up in the
"tree")
Hint: You can sort the file list using the column headers, as you would do in
Explorer. The files will always be processed in the displayed sequence useful when you're using the Numbering facility.
Please note that, if you rename a folder whilst using the recursive (subfolders)
option, after the rename is complete the file list will be refreshed automatically.
This is to prevent problems whereby the file-list becomes out of synchronisation
with the files on your hard drive. If you don't rename a folder (just files), or if
you rename anything whilst not using the recursive option, then no refresh is
necessary.

The criteria are processed from left to right, according to the number listed
against each section. So for example, a text replace will be performed before a
change of case. The specific operations are as follows:
1) Apply any fixed name-changes from an imported text file.
then
2) Apply any Regular Expression reformatting
then
3) Remove any file name, or use a fixed name,

then
4) Perform any text substitutions
then
5) Perform any changes of case
then
6) Remove n digits from the start, middle or end of the filename, and optionally
remove certain characters, and/or all characters, and/or all digits and/or all
symbols and/or all high-ascii characters.
then
7) Move any text from the start, middle or end of the filename to the start,
middle or end of the filename
then
8) Add any prefixes or suffixes, or apply text to the middle of the filename.
Suffixes are added at the end of the filename, i.e. before any file extension
then
9) Apply any "auto-date" text as a prefix or suffix. "Sep" is the text to insert
between the filename and the date; "Seg" is the separator between the day,
month, year, hour, minute and second segments. Or you can use a custom
format.
then
10) Add the containing folder name as a prefix or a suffix, with a user-defined
separator
then
11) Perform any auto-numbering

then
12) Make any changes to the case of the file extension, or change the extension.
Full details about the various fields can be found here.

If you are not using the Regular Expression facility then both the Regular
Expression Match and Replace fields must be left blank.
The selected files will be renamed according to your selection criteria. You can
select multiple files by holding down the SHIFT or CTRL keys. If there are any
problems with the rename operation then you will be given the option to roll
back (undo) the operation.
Remember - you can always preview the new name in the column on the far
right. This allows you to refine your criteria before actually renaming the files.
To preserve your renaming criteria for the next time you use the utility, look at
the Favourites facility.
You can use the Reset button to reset all your renaming criteria back to the
default values (or the smaller R buttons to just reset one group).

Remove Symbols
Note that the "Remove Symbols" option removes the following symbols (some
of which are not valid in filenames anyway):
!£$%^&*()-_=+[]{};:'@#~,.<>/?\|`¬¦

The Main Screen
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Once you launch the application the main screen is laid out in a similar way to
Windows Explorer. Below the menu bar are two panes, the left of which is a
tree view providing easy access to your system drives and folders. The righthand pane is a list view of the files and folders contained within the currently
selected branch of the tree shown over on the left.
Below the navigation panes are a series of controls. The controls are grouped
together according to function - for example, all the facilities to remove text
from a filename.
The rules used by the Bulk Rename Utility are processed in the order that the
controls appear. i.e. from left to right. For example, you can't convert case
before performing a replacement. However, it maybe possible to achieve the
desired results by using the Bulk Rename Utility multiple times on the same
folders and files using different rules. Names are not actually changed until the
"Rename" button is clicked, but you can always see a preview of the proposed
filename in the New Name column. Note that this column is only updated for
the files which are selected.
`
If you have any of the criteria set in such a way that it will affect the filenames
(i.e. it contributes to the new filename) then the title of that grouping will be
shown with a yellow background (assuming you haven't disabled this option on
the Options menu), as shown below:

The controls at the bottom of the screen can be explained as follows:

Expression
This allows you to enter a regular expression match and replace. Regular
Expressions are a complex subject (a 400-page book exists on the subject) more details can be found here. If you are not using Regular Expressions then
both of these fields must be left blank. Do not confuse these fields with the
Replacements fields found elsewhere on the screen.

Filename - this allows you to manage the actual raw filename
Filename drop-down - This control has three options: Keep, Remove and
Fixed.
· Keep will ensure that the original filename is not changed (default).
· Remove will completely erase the filename from the selected items.
· Fixed allows a new filename to be specified for all selected items. Only
really useful if you're also using the Numbering section.
· Reverse allows you to reverse the name, e.g. 12345.txt becomes 54321.txt.
Useful to somebody, I'm sure!

Replacements - allow you to replace occurrences of one text string with
another
This section consists of two controls. You must specify the text you wish to
find, and the text you wish to replace it with. It is possible to find a text string
and replace it with an empty string, or with a shorter string, or with a longer
string. You may also specify whether or not you want the "find" processing to
be case-sensitive. Note that the text is always replaced with the text you specify,
including any specific text case.

Case - Allow the changing of case
Case drop-down - allows the capitalisation of file and/or folder names to be
changed.
· Same - leaves the original capitalisation intact.
· Lower - converts all letters in the name(s) to lower-case.
· Upper - converts all letters in the name(s) into capitals.
· Title - converts all the words in the selected items to initial caps. A word is
generally defined as a string of letters proceeded by a space or a bracket. So
"joe public.txt" would become "Joe Public.txt" but "joe-public.txt" would
become "Joe-public.txt".

· Sentence - converts all the words in the sentence to Sentence format.
Basically this means capitalising the first letter of the first word after every
full stop (.). So "hello EVERYONE. MY name IS FreD.txt" would become
"Hello everyone. My name is fred.txt"
You can also enter a list of "exceptions", separated by colons. So for example if
you entered PHP:ASP:doc then any occurrence of php or ASP (or pHP or aSp)
would be converted to upper-case, and every occurrence of DOC (or DoC)
would become doc.

Removals - Remove parts of a filename
This section consists of four separate facilities for removing parts of a filename.
Note that these do not apply to the file extension, just the name.
· First n chars - Remove the first n characters from the name. E.g. removing
the first 2 characters from "Joe Public.txt" will result in "e Public.txt"
· Last n chars - Remove the last n characters from the name. E.g. removing the
last 2 characters from "Joe Public.txt" will result in "Joe Publ.txt"
· From n to n. This allows you to remove a string of text, e.g. from the 6th to
the 9th characters.
· Chars - Remove occurrences of characters from the name. E.g. typing
"QW:#" will result in all occurrences of Q, W, colon and hash being
removed.
· Words - Remove occurrences of words (separated by spaces)
· Crop - Remove any text which occurs before (or after) a specific character or
word. See below.
· Digits - Remove all occurrences of the digits 0-9 from the filename.
· Chars - Remove all characters
· Sym - Remove all symbols
· High - Remove high-ASCII characters (chars from 128 to 255)
· Trim - Remove leading and trailing spaces
· D/S - Remove occurrences of double spaces, and replace them with single
spaces

· Accent - Remove accented characters and replace them with non-accented
versions. See here.
· Lead Dots - remove the . or .. from the front of filenames (useful if you've
copied from a Linux/Unix system).
When you use the "crop" option, you have the option of specifying a "special"
value using the wildcard (*). This will remove the specified string, and any
characters occupied by the wildcard. So for example, specifying [*] would
convert "Hello[ABC] Joe" to just "Hello Joe", as it has removed the two square
brackets and everything between.

Move/Copy - Move a section of text to a different place
This allows you to move (or copy) a fixed number of characters form one part
of the string to another. You could do this with Regular Expressions of course,
but this gives you an alternative. So for example, if all your filenames end with
a unique 6-digit sequence code, and you'd rather have this at the start of the
filename, then this is the simplest way to achieve it.

Additions - Add a fixed prefix or suffix to the filename, and certain Exif
and ID3 tags
This allows you to add a fixed text string to the start of the filename, and also a
fixed text string to the end of a filename. Useful for renaming MP3 files, where
you can prefix all the filenames with the artist or album name. You can also
insert a text string at any point in the filename.
If you are processing JPEG files, you can also extract certain EXIF tags. These
are specified using substitution tags, which you key into the Prefix, Insert or
Suffix boxes (box 7). The tags current available are:
%a - Aperture
%c - Comments
%e - Exposure
%f - Focal Length

%xb - Exposure Bias
If you are processing MP3 files, you can also extract certain ID3 tags (n.b. only
V1 and V1.1 ID3 tags are supported). These are specified using substitution
tags, which you key into the Prefix, Insert or Suffix boxes (box 7). The tags
current available are:
%r - Artist
%l - Album
%t - Title
%k - Track Number

You can also specify %z to include the file size (using the format currently
specified on the Options menu)
You may also choose to add a "WordSpace". This will insert a space before any
capital letter (except the first character), unless there's a space already there. So,
the name "MyHoliday Photographs" would become "My Holiday Photographs".

Auto Date - Add various dates to the filename, in various formats
This allows you to prefix or suffix the filename with a variety of dates - the date
that the file was created, modified, or accessed, and also with the current date.
Useful for pictures! The date can be added in 9 different formats, some of which
also include the modification time. You can also specify the characters you
would like placed between the date/time and the existing filename (the Sep
field) and the character to place between the different date/time segments (the
Seg field). e.g. a format of DMY, with a Seg field of "-" would give a date of
(for example) "25-01-03". The "Cent." flag is used to indicate whether or not
you would the year to be represented with two digits or 4 digits.
You also have the option to specify your own custom date formats, and these are
detailed here.
If you are also updating the file's Creation-date or Modified-date, then you can
also choose the "Create (New)" and "Modified (New)" values, and these will
equate to your new timestamps.

Several of the dates you can use relate to "data taken". These are EXIF flags
which are often embedded in figital camera images which were created using a
digital camera. The software will only get the flags from JPEG images (.JPG or
.JPEG extension), TIFFs (.TIF, .TIFF), Nikon (.NEF) and Canon (.CR2) files. If
no date is available then no date will be used. So for example, choosing to
append a Date Taken field for a .EXE file will simply append nothing. The dates
are:
· Date Taken (Original) - the original timestamp, which should never change
· Date Taken (Digitised) - The original timestamp, but if the file has been
edited (Canon Digital Photo Professional etc.) then this date is updated
· Date Taken (Modified) - The standard "DateTime" EXIF field, which is
usually updated if you edit the picture
· Date Taken (Recent) - the most "recent" of all three. By recent, this means
the last timestamp in the file, not necessarily the most recent in time. This is
purely to retain the same behaviour as previous versions of Bulk Rename
Utility.

Append Folder Name - Add the name of the containing folder(s)
This option allows you to append (or prepend) the name of the containing folder
to the filename. So for example, if you had a file called "Dancers.jpg" in a
folder called "Highland Show August 2003" then you could automatically
rename the file "Highland Show August 2003 - Dancers.jpg". Useful if you
have lots of folders, each containing the same group of files, and you want to
merge all the files into a single folder.
You can specify a separator character(s) to use between the folder name and the
file name.
You can also specify how many folders to append. So for example, if you had a
picture called Cat.jpg in C:\Documents and Settings\Administrator\Pictures, and
you chose 4 levels, then you might end up with

C-Documents and Settings-Administrator-Pictures-Cat.jpg
The software will automatically remove the ":\" from the root (e.g C:\) as these
two characters are illegal in filenames.

Numbering - Add sequential numbers
This allows you to sequentially number a group of files. Several criteria exist:
· Mode - specify whether you want the number to be appended to the start of
the filename, or the end of the filename, or both.
· Start - Specify a starting number
· Increment - The number by which you want each filename number to be
incremented.
· Pad - The minimum number of digits occupied by the numeric element.
Bases 1-36 will be padded with leading zeros; the a-z and A-Z options will
be padded with "a" or "A" as appropriate.
· Separator - A character or characters that you wish to be inserted between the
filename and the number
A common scenario would be:
· Mode - Suffix
· Start - 1
· Increment - 1
· Pad - 4
· Separator - This would result in filenames with suffixes of -0001, -0002, -0003, -0004 etc.
You can choose to append the auto-number in any numeric base, from base 2 to
base 36. e.g. a value of 26 in base 16 would be appended as 1A.
The final control in this section allows you to convert Roman Numerals to
upper of lower case. For example, if you had a file called "Beethoven's niNTH
syMPHONY part iii" You might want to use Title Case to format the filename,

but this would mess up the "iii". Use this control to handle the Roman Numeral
element. Note that the Utility identifies numerals when separates by a space
character.
If you enter the special character ":" (colon) in the "Sep." box then this will be
replaced with the autonumber at runtime. So a separator value of ABC:DEF:
would result in ABC1DEF1, ABC2ABC2 etc.
There are two ways to get the autonumber value to reset. Firstly, if you tick the
"Folder" box and you're processing subfolders, the autonumber will reset upon a
change of subfolder. Clearly this is only really useful if the listing is sorted by
the subfolder column! A second way is to enter a "break" value. This will cause
the numbering to reset when the nnn character changes. e.g. enter 4 to cause the
number to reset when the 4th character of the NEW name changes.

Extension - Allow the changing of case of the filename extension
Case drop-down - allows the capitalisation of file and/or folder names to be
changed.
· Same - leaves the original capitalisation intact.
· Lower - converts all letters in the extension to lower-case.
· Upper - converts all letters in the extension into capitals.
· Title - converts all the words in the selected items to initial caps, e.g. Jpeg.
· Fixed - replace the extension with a fixed extension. For example, use this
option to set all your files to ".doc" types.
· Extra - Add a secondary extension. For example, change my.holiday to
my.holiday.gif
· Remove - Remove any file extension. e.g. My.Holiday becomes My

Selections - which files or folders you are working on. This is known as
the file mask. By default this will be all the files and folders in the current
folder. Note that this section is only used to govern which files/folders are
displayed. You still need to select a file or folder in order to rename it.

· Filter - specify a file-mask to use. Normally this would be *.*, or *.mp3, or
*.doc etc. Note that this section is only used to govern which files/folders are
displayed. You still need to select a file or folder in order to rename it. So for
example, entering a filter of "*.mp3" means that only your MP3 music files
will be shown. You can enter multiple file-masks by separating them with a
space, e.g. "*.mp3 *.doc *.xls". Please note - changes to this field only take
effect when you move the cursor to a different field or click a different
control. This is to prevent the list from rebuilding with each keystroke as you
type. You can also prefix a criteria with the exclamation mark (!) to perform
a "not" expression. So "* !*.doc !*.mp3" will select everything except Word
documets and MP3 files.
· Folders - include folders in the listing
· Files - include files in the listing.
· Subfolders - if the Subfolders option is checked, Bulk Rename Utility will
process the contents of all sub-folders in the selected branch of the file
hierarchy. Care should be taken when using this feature as the utility can
potentially list every file on your system
· Hidden - checking this box will mean that they will be processed. Important
- you should be careful using this option as many Windows system files are
hidden and renaming them could have a detrimental effect on the
functionality of your system.
· Min. Len. - only files/folders whose names are greater than (or equal to) this
length will be processed. Useful if you want to rename files greater than 64
characters for putting onto a CD, for example. NB This will exclude files and
folders, if the file/folder name is shorter than the nominated length. However,
in a recursive scan, sub-folders will still be scanned regardless of the length
of the subfolder's name
· Max. Len. - only files/folders whose names are lesser than (or equal to) this
length will be processed. Useful if you want to rename files greater than 64
characters for putting onto a CD, for example. NB This will exclude files and
folders, if the file/folder name is shorter than the nominated length. However,
in a recursive scan, sub-folders will still be scanned regardless of the length
of the subfolder's name

New Location - This allows you to leave the original files intact, but

create copies of the files (with new names, of course) in a separate folder. This
option will honour the "Overwrite Target Files" menu option.

Command Buttons
· R - at the top of each group of controls there is a button entitled simply R.
This will reset the criteria in that particular box.
· Checkbox - at the top of each group of controls there is a checkbox. This will
enable or disable an entire "group" without wiping out your settings. Useful
if you want to temporarily disable some criteria,
· Reset - Reset all your renaming criteria to the default values
· Revert - Reset all your renaming criteria to the values from your current
Favourites file (if loaded).
· Rename - Actually perform the rename operation, using the criteria you have
entered, on the files you have selected. You can always see the number of
selected files in the utility's status bar. Note that this button is enabled once
you have selected one or more files for renaming.

Zoom
Note that many of the text fields on the screen are quite small. To allow for
reasonable editing you can press F8 on these fields to display a new, larger
window.

Changing File Attributes
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Bulk Rename Utility allows you to change the attributes of files and folders
once they have been renamed. This can be useful if you wish to flag all renamed
files/folders as requiring archiving, or if you want to hide all the renamed
files/folders. As well as making a file read-only, hidden etc., you can also clear
the same flags.
Each of the main File Attribute settings is shown in the dialog window:

For each of the attributes you can choose to set the attribute, clear the attribute,
or leave it unchanged. This gives you flexible control over how the files and
folders will appear once they have been renamed.
If you are updating the file's attributes information, this will be reflected in the
application main window, as the attribute field will be coloured
Note
If you set the Hidden or System attribute for a file, it will disappear from the
main window upon renaming if you do not have Hidden or System options
ticked in the Selections group (group 12).

Changing File Timestamps

Top Previous Next

Bulk Rename Utility allows you to change the timestamp information for files
and folders once you have renamed them. This is useful if you have certain
applications which use a file's timestamp in order to identify if a file has been
modified, of if you want to sort photographs in a particular sequence. Some
older applications even use the timestamp to identify a product version.

You can choose a new date and timestamp for the Created Date, Modified Date
and Accessed Date, and they are independent of each other. You can also choose
a value of "Current" which will use the current date and time at the time of
renaming.
You can also apply a delta. This is a value in days, followed by HH:MM:SS,
and this value will be added (or subtracted) from the timestamp. So for
example, if you rely upon timestamps and you realise your computer's clock is
wrong, you can use this facility to batch-correct the timestamps. n.b. This will
NOT update the "date taken" information held within a picture file.

If you are updating the file's timestamp information, this will be reflected in the
application main window, as the appropriate date field will be coloured.
If you would like to set the Modified and Accessed timestamps to be the same
as the Created timestamp then choose the Created option.
Note that the Date Taken option is always the Date Time Original EXIF flag.
Windows 98 Users
Please note that timestamps on directories cannot be changed (the Windows API
simply doesn't exist in '98).
FAT versus NTFS
The FAT (File Allocation Table) file system, which is used by Windows 98 and
Windows ME (and 2000/XP if you've not converted to NTFS) holds timestamp
information differently to NTFS. Basically, it doesn't hold any Daylight Saving
Time information. As such, the timestamp activity will operate slightly
differently on a FAT file system.

Character Translations
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Character Translations allows you to enter a specific character or sequence of
characters, and have that translated into a different character or sequence of
characters. So for example, you could specify that you always want a $ sign to
be converted into the word DOLLAR.
There are three ways to enter the replacement data:
1. As a character, e.g. A
2. As a hex value, e.g. 0F
3. As a decimal value, e.g. 065
Separate the FROM and the TO conversions with an equals sign. If you wish to
actually convert an equals sign to/from something else then you can specify the
hex or decimal value for the equals sign in your rules.
Bulk Rename Utility identifies the type of value entered by its length. So if your
value is one character long then it's a direct character; two characters long and
its a hex value; three characters long and its a decimal value.
In the following examples, every example is converting a capital "A" to a
capital "B"
·
·
·
·
·

A=B (direct expression of the characters to convert)
41=42 (two character long, therefore hex values)
065=066 (three characters long, therefore decimal values)
A=066 (using a mixture of the above)
41=066 (using a mixture of the above)

If you wish to to convert several characters then you can separate the values by
commas. So the following example will convert ABC to DEF:
· 41,066,C=D,E,070
If you wish to actually convert a comma sign to/from something else then you

can specify the hex or decimal value for the comma sign in your rules.

Using the Picture Viewer
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Bulk Rename Utility allows you to display a preview window, which will show
the picture for the currently selected file. Only certain file-types are supported,
these being jpeg (JPG), bitmap (BMP) WIndows Metafiles (WMF) and
Compuserve Graphical Interchange Format (GIF).
In addition, you can only display the picture for a single file; if you select
multiple files then no preview will be displayed.

Drag and Drop from Explorer
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Starting from version 2.4.0.0, you can now drag files and folders directly from
within Windows Explorer. This means you can select files from anywhere on
your computer and aggregate them all together, allowing you to rename them in
a single operation.
To perform this task, launch Bulk Rename Utility in the normal way. Then
launch Windows Explorer (or My Computer), and find the files or folders that
you wish to process. Select all the files/folders and drag them over the Bulk
Rename Utility "file list" window (you should see the icon change). Then let go
of the mouse, and the files will be listed.
As this function is available for ANY Explorer window, you can even use the
inbuilt Windows "Find" facility to find files on your computer (for example, all
your Word documents) and then drag the files directly from the Search Results
window.
It's important to note that when you drag the files/folders across, you are NOT
performing any operations on those files. You have not moved those files! You
are simple displaying them in the Bulk Rename Utility window for subsequent
processing.
Note that any files/folders you drag on the window will be added to the list of
files/folders already there. If you instead wish to show ONLY the files you are
dragging then simple hold down the CTRL key when you let go of the mouse
button.

Actions Menu
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The actions menu provides you with a variety of shortcuts to speed up common
tasks, and these are described below.

Select All
This will quickly select all the files and folders in the file-list window.
Deselect All
This will de-select all the files and folders in the file-list window.
Invert Selection
Any entry which is currently selected will be de-selected, and vice-versa. Handy
for two-pass renames, where you want to rename a whole batch of files in one
go, then rename "everything else" in another go.
Select from Clipboard
If you have a list of filenames on the clipboard (such as the output from DIR /B)

then the software will try to select files which match the names from the
clipboard.
Jump to Path
This option will display a pop-up window, allowing you to the type a full
pathname to navigate to. The path must exist (it will be validated) and it must
map to a drive letter - UNC paths are not supported.
Refresh Files
This will refresh the contents of the right-hand file-list window
Refresh Tree
This will refresh the contents of the left-hand tree window. Note that you can
refresh the contents of the selected branch by collapsing and re-expanding the
branch.
Show/Hide Tree
This will collapse or expand the folder "tree". This is useful if you have located
your folder and you are now doing lots of work in the one folder. The "tree" can
be removed to give you more space. Note: The tree will always be visible at
program startup, even if it was hidden when you closed the program.
Undo Rename
If you have just performed a rename activity, and then said "oops..." then this is
the option you need. This function will "undo" your last rename activity
(including any timestamp and Attribute changes you made. The files are
processed in reverse order, so even if you renamed folders, and files within the
folders, the full operation should be reversed successfully. Obviously it's better
to rename the files correctly in the first place....
Create Undo Batch File
Similar to Undo Rename (above), this will allow you to create a DOS batch file
which can be run from the command line, and which will reverse out your last
renaming operation.
Zoom
This allows you to launch a new window to edit the current text field. Space on
the screen is limited, and some fields are quite small, so this option allows you
to enter long text with ease. You can type text into the new window, in a larger

font, and the text will then appear in the field on the main screen.
Random Sort
This allows you to sort the file-list in a random sequence. Useful if you want to
create a slideshow in a random display-sequence. Once you've sorted in random
order, apply a numeric auto-number prefix to keep the list in that order.
Reset All Criteria
This allows you to quickly reset all the renaming-criteria which are currently
selected. Handy if you want to start from scratch. (This won't reset your fileselection and new-location items, groups 12 and 13).
Rename
Actually perform the rename. This is just an alternative to pressing the button
on the screen,
Clear Imported-Pairs
If you have imported file-renaming pairs then this option will wipe out the list
of pairs from memory. Normally the list would only be removed by loading a
different list or by exiting the application.

Debug New Name
If you have a one (and only one) file or folder selected in the right-hand pane
then this menu item becomes available. What this will do is display a simple
dialog box which shows how the file's "new name" has been derived. This can
help when you are using lots of the controls and boxes, and you aren't getting
the end result that you are expecting.

Removing Accented Characters
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Many filenames contain accented characters, e.g. French filenames might
contain à and á, whereas English language speakers are happy to use the Latin
alphabet. Bulk Rename Utility provides a facility to replace accented characters
with non-accented characters.
If you are using a Unicode build of Bulk Rename Utility (Windows
NT/2000/XP/2003/Vista) then you should find that virtually all accented
characters are converted into their non-accented equivalents (à becomes a, etc.).
If you are using Windows 98 then this has to be done using a hard-coded list of
characters, which is as follows:

ASCII SHOWS HEX CONVERTED
TO
131
83
f
138
8A
S
142
8E
Z
154
9A
s
158
9E
z
159
9F
Y
162
¢
A2
c
165
¥
A5
Y
170
ª
AA
a
181
µ
B5
u
192
À
C0
A
193
Á
C1
A
194
Â
C2
A
195
Ã
C3
A
196
Ä
C4
A

197
199
200
201
202
203
204
205
206
207
208
209
210
211
212
213
214
215
216
217
218
219
220
221
224
225
226

Å
Ç
È
É
Ê
Ë
Ì
Í
Î
Ï
Ð
Ñ
Ò
Ó
Ô
Õ
Ö
×
Ø
Ù
Ú
Û
Ü
Ý
à
á
â

C5
C7
C8
C9
CA
CB
CC
CD
CE
CF
D0
D1
D2
D3
D4
D5
D6
D7
D8
D9
DA
DB
DC
DD
E0
E1
E2

A
C
E
E
E
E
I
I
I
I
D
N
O
O
O
O
O
x
O
U
U
U
U
Y
a
a
a

227
228
229
231
232
233
234
235
236
237
238
239
240
241
242
243
244
245
246
248
249
250
251
252
253
255

ã
ä
å
ç
è
é
ê
ë
ì
í
î
ï
ð
ñ
ò
ó
ô
õ
ö
ø
ù
ú
û
ü
ý
ÿ

E3
E4
E5
E7
E8
E9
EA
EB
EC
ED
EE
EF
F0
F1
F2
F3
F4
F5
F6
F8
F9
FA
FB
FC
FD
FF

a
a
a
c
e
e
e
e
i
i
i
i
o
n
o
o
o
o
o
o
u
u
u
u
y
y

Context Menu
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If you right-click an item in the right hand window (e.g. a file folder) you will
be presented with a Context menu (or "Shell" menu). You will see the standard
Windows context menu (with options to Edit, Delete, Copy etc.), with four
additional menu options in a new "Clipboard Copy" sub-menu. NB on certain
"system" files and folders you will just see the Clipboard options.
The "Clipboard Copy" menu items allow you to copy various pieces of
information, such as the filename or folder path, to the Windows clipboard.
Important Note:
Two important notes with regards to the Shell menu:
1. If you perform an operation on a file/folder using the Shell menu which
changes the name of that file, or deletes the file, then this is not
automatically reflected in Bulk Rename Utility. This avoids unnecessary
rebuilding of the file listing.
2. If you are using the "sub-folders" option, and you select multiple files which
span two or more folders, then the right-click context menu might give
unpredictable results.

Saving your Settings
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When you quit the application, your current settings (menu choices etc.) will be
stored in a .INI file in the same folder as the executable program. Whilst this
goes against Microsoft's philosophy, INI files are actually much better than the
registry! You can take your folder with you and use it on any system, knowing
that it's already configured for you! As Bulk Rename Utility doesn't require an
Installer this makes it quite useful as a utility on a "memory stick" or a "Tools
CD"
If you need two sets of preferences with different values then create two copies
of the executable with different names, and you'll get two INI files.

Renaming From A Text File
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Starting with version 2.2.6.0 it is possible to rename files according to a textfile. This text file should contain a list of "old name" and "new name" pairs,
separated by a pipe symbol ( | ).
To use this facility, create a text file in for the correct format, for example:
Track001.mp3|Headlong.mp3
Track002.mp3|Rushes.mp3
TRACK003.mp3|AnywhereIs.mp3
As you see, there is one entry per line.
Next, click the Import option on the File menu and load your file. If the file is
valid then you will see the "new name" column reflecting the contents of the
text file.
When comparing the current filename with the text file the application ignores
the case of the filename, e.g. it will happily match Track001.mp3 and
TRACK001.mp3. This makes it easy to rename the files.

Options Menu
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The options menu provides you with a variety of methods to customise the
application. These are described below.

Always On Top
This will keep the Rename Utility window on top of all other windows.
Favourites > Save On Exit
This will save any changes to the current Favourite whenever you exit the
application.
Favourites > Store Pathname
If you store the pathname with a Favourite, when you choose the Favourite the
saved path is also selected. If you un-tick this option, selecting a new Favourite
will leave you in the current folder.

Display > Gridlines
Some people like gridlines, others don't. You decide!
Display >Icons
Choosing to not display icons can sometimes speed up long file-listings
Display > Highlight Active Criteria
With this option ticked, whenever you make a change to one of the "criteria
groupings" (e.g. Additions, Removals) that will have an effect on the filenames,
the heading for that grouping will be highlighted. This allows you to quickly
identify which of the groupings is having an effect on your filename. An
example is shown below, where there is an active criteria in place - the heading
is now yellow:

Of course, you can quickly press the "R" icon to reset the criteria for that
grouping.

Display >Warning Message
This allows you to control whether or not you are warned prior to renaming
files. Useful until you are confident with the software.
Display >Confirmation Message
Control whether or not you receive a confirmation message after the renaming
is complete.
Display >Picture Viewer
This option will open a second, resizable window, which will display an image
if you select a single JPEG, Bitmap or EMF file. The file-types supported are:.
BMP, RLE, DIB, GIF, JPG, WMF, EMF
Display >File sizes as...
This option allows you to control how file-sizes are displayed.You can specify
that all files be shown in Bytes, Kilobytes, Megabytes or Gigabytes. You can
also choose "Mixed" which will show files in the unit most suited to their size
(ie.g. a file of size 1224555 Bytes will be shown in Megabytes.

Colours > New Name OK...
This allows you to choose the colour used to display the new filename, if the
new filename is acceptable to Windows. This means that it does not contain
illegal characters.
Colours > New Name Invalid...
This allows you to choose the colour used to display the new filename, if the
new filename is not acceptable to Windows. This means that it contains illegal
characters such as \ or ?. The list of illegal characters is displayed if you attempt
to rename the files.
Colours > Active Criteria...
This allows you to choose the colour used to highlight the active criteria. This is
only applicable if you have opted to highlight active criteria on the Options >
Display menu. Please note that any changes made to this option will not take
effect until you restart the application.
Full Row Select
With this option ticked, when you select a file/folder the entire row will be
highlighted. Without it ticked, only the first column will be highlighted. Note
that files which will be renamed are highlighted in red text (right-hand column),
but this is only possible when you don't select the Full Row Select option.
Auto-Select Entries
With this option selected, when the list of files/folders is built, the files/folders
will be selected automatically. This means you do not have to manually select
entries in order to rename them.
Sorting > Logical Sorting
This option allows you to sort filenames according to the default Windows XP
sort-sequence. This allows files containing numbers to be sorted logically,
e.g.1.txt, 2.txt, 10.txt, 11.txt, 21.txt. The default sort-sequence for all operating
systems earlier than XP is to use absolute sorting, e.g. 1.txt, 10.txt, 11.txt, 2.txt,
21.txt.
Sorting > Group Affected Files
This option allows you to sort your file listing in the normal way, but with all
"affected" files together. Therefore, all files with "new names" will be sorted

together, and all files which are not affected by your renaming criteria will be
sorted together. When you click a column-heading to sort the files, all the files
which are affected (normally shown in green) will be grouped together. Note
that this does not apply to the Size, Date or Attributes columns.
Sorting > Sort Files and Folders Together
With this option selected, files and folders will be sorted together, intermingled
according to their name. This differs from the normal Windows Explorer view,
where folders are sorted together and then files are sorted together.
Overwrite Target Files
With this option selected, if the destination filename for a rename operation
already exists, that file will be overwritten. So for example, if you had files
called a.txt, b.txt and c.txt, and your renaming-criteria caused file a.txt to
become c.txt, file c.txt will be overwritten. As such, you need to use this option
with extreme caution - if you enter incorrect renaming criteria then you could
destroy valuable files very easily!
This option is honoured if you choose to copy files to a new location (box 13 on
the screen).
New Location Copy not Move
If you are choosing to rename files to a new location (see box 13 on the screen),
this option will determine whether files are copied, rather than moved.
Retain Autonumber
If you are using an Autonumber in your renaming then this option will allow the
last-used number to be retained. So for example if you start at 1 and rename 5
files, after the rename is compete the "start at" value will show 6. This is useful
for renaming in lots of batches but keeping the numbers contiguous.
Prevent Duplicates
This option allows to you to overcome the situation whereby a rename would
fail because a file with the same name already exists. If you try to rename a file,
and there's already a file with the same name, the software will make up
subsequent attempt to rename the file but with a "_1" suffix. If this fails it will
try with "_2" as the suffix, and will continue up to "_99". The limit of 99, and
the separator character (underscore, _) are currently fixed and cannot be
changed.

Rename in Reverse Order (Advanced Option)
Normally files are renamed from top to bottom, e.g. the first item in the list
followed the second item etc. But this can cause you problems if files already
exist. Let's say you want to rename 1.txt to 2.txt, 2.txt to 3.txt, and 3.txt to 4.txt.
Normally the first rename (1.txt to 2.txt) would fail because 2.txt already exists.
This option will overcome this, as the files will be processed in reverse order.
This option is only required on rare occasions.
Extract Exif Data
Use this option to say whether or not EXIF tags will be extracted from
photographs. At present only Date Taken, Aperture, Exposure, Focal Length,
Exposure Compensation and Comments are extracted, but even this can slow
down the processing a lot. If you don't need these fields then leave this option
un-ticked to speed up the processing. Only files with the following extensions
are processed: .JPG, .JPEG, .TIF, .TIFF, .CRW, .CR2, .NEF.
Extract ID3 Data
Use this option to say whether or not ID3 (Version 1) tags will be extracted
from MP3 files. At present only Artist, Album and Title are extracted, but even
this can slow down the processing a lot. If you don't need these fields then leave
this option un-ticked to speed up the processing.
Ignore Folder Extensions
With this option selected, any "extensions" within folder names will be ignored
- this is because extensions have no real meaning, unlike filename extensions
which identify the file type. So for example, if you have a folder called
"Holidays.2004". and you choose to remove the last 2 characters, the resulting
folder name will be "Holidays.20" or "Holida.2004", depending upon the status
of this option.
Ignore File Extensions
With this option selected, any filename extensions will be ignored, and your
operations will affect the entire filename. Use this option with great care, as
Windows relies heavily on the filename extension to decide what to do with a
file.
Log Activity
Use this option to record a log of all your renaming activity (including undo

requests). The log file will be created in the same folder as the Bulk Rename
Utility executable file, and will have the same name as the EXE but with a .log
suffix. Please note that only renaming activity is logged, not changes to
attributes or timestamps.
Attributes
This option allows you to specify which file attributes you would like to set or
clear (or leave alone) on renamed files. Please note that only files are updated
(not folders) and the attributes are changed after the rename.
Timestamp
This option allows you to specify a new date and time to be assigned to Created
and Modified file-attributes. You can choose a pre-set date or the current date,
or you can enter any date using the keyboard or the "spin" controls.

Using Favourites
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A Favourite is a collection of configuration values which can be used to provide
quick access to commonly-used criteria. For example, if you frequently want to
rename a bunch of pictures in one folder, and you frequently want to rename a
bunch of sound files in another folder, then you could create two Favourites
called Pictures and Sound Files. Each Favourite holds with it the selection
criteria, rename criteria, and current folder.
When you launch the application for the first time you will not have any
Favourites defined, but you can create favourites in the same was as you would
create text files or pictures. Store them anywhere on your hard drive and use
them as you wish.
Each individual Favourites file contains all the criteria you used to rename files.
So for example, you could create a Favourite for renaming your pictures; a
Favourite for stripping dodgy characters out of filenames etc. You can then
recall these Favourites whenever you need them.
To use favourites, just use the Open and Save/Save As menu options in the same
way as you would do in Word or Excel and other programs. When you choose
to save a favourite, all the settings currently in place will be saved into that
favourite. You can then recall these quickly, either from the Open command or
by double-clicking a Favourite file in Windows Explorer. Favourites files have
the file extension .bru.
If you have loaded a Favourite and made changes to it, but wish to revert back
to the original version, then choose the Revert option on the File menu.

Regular Expressions
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The applications support powerful Regular Expression processing. This allows
you to enter a flexible Match expression, and a flexible Replacement
expression, and the program will generate the appropriate name using these
expressions. For example, you can use RegExp strings to swap two words in a
filename, or remove numbers, or apply fixed formatting.
A full description of Regular Expressions is beyond the scope of this help file,
but a wide range of resources is available on the internet (e.g.
groups.google.com). However, the syntax supported by this program is the same
as that offered by PERL 5. The precise implementation is via the PCRE Library,
and (at the time of writing) full notes on the Perl Regular Expression syntax can
be found here.
A summary of the syntax is:

CharacterUsage
*

Matches the previous character zero or more
times
+
Matches the previous character one or more
times
?
Matches the previous character zero or one
times
.
Matches any single character except the
newline
^
Matches the start of the input
$
Matches the end of the input
x|y
Matches either first or second character
listed
(pattern)
Matches pattern
{number}
Matches exactly number times
{number,}
Matches number, or more, times (note
comma)
{num1, num2} Matches at least num1 and at most num2
times
[abc]
Matches any character listed between the [ ]

[^abc]
[a-e]
[^K-Q]
\
\b
\B
\f
\n
\r
\s
\S
\t
\d

Matches all characters except those listed
between the [ ]
Matches any characters in the specified
range (a,b,c,d,e)
Matches all characters except in the specified
range
Signifies that the next character is special or
a literal.
Matches only on a word boundary
Matches only inside a word
Matches only on a form feed character
Matches only on a new line
Matches only on a carriage return
Matches only on a blank space
Matches only on nonblank spaces
Matches only on a tab
Matches any digit

Replacements are usually performed on the basis of "components, and these are
defined using \ notation, e.g. \1 matches the first element, \2 matches the second
Example Regular Expression:
Match:
Replace:

(Louis Armstrong)(.\[0-9].)([A-Za-z ]*)
\1 \3

A more detailed working example can be found here.
You can choose whether or not to pass the filename extension to the Regular
Expression engine, or just the filename itself.

Regular Expressions - A Working Example
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Assume you have a file called Program Files, and you wish to swap the names
around (e.g. Files Program). A Regular Expression which performs this task is :
^([A-Z][a-z]*) ([A-Z][a-z]*)
Let us break this down into components:
^ This means start at the beginning of the string
([A-Z][a-z]*) This is a single "group", which we will use later. What this says is
that we want any capital letter, followed by any number of lower-case letters.
The single capital letter is denoted by the [A-Z], i.e. allow a letter in the range A
to Z. The lower-case letters are denoted by [a-z] in the same way, followed by
an asterisk. This means we can allow any number of letters.
We then allow a single space. If I had wanted multiple spaces I would probably
have typed "space asterisk", or possible ( *) to group.
We then have exactly the same again, i.e. we are denoting two words.
Notice we had two sets of brackets. Everything within each set of brackets is
treated as a "grouping", and we refer to these groupings as \1, \2, \3 etc.
So, lets say we wanted to swap around the two words in the filename. We would
put:
^([A-Z][a-z]*) ([A-Z][a-z]*)
For the match string, and
\2 \1
As the replacement string. Of course, we're free to manipulate the replacements
string as we like. For example, it would be quite valid to have:
The \2 which are used to run the \1
For the replacement string. This would result in:

The Files which are used to run the Program.
The above example is very precise. If we wanted to swap the first two words of
a name, but keep the remaining text the same, we could put
^([A-Z][a-z]*) ([A-Z][a-z]*)(.*)
\2\1\3

This says to create three groups: the first group is the first word, the second
group is the second word, and the third group is everything that's left.

Bulk Rename Here
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When you install Bulk Rename Utility you have the option of installing
"Context" menus. If you choose this option (recommended), you will find a new
Bulk Rename Here facility when you right-click a file or folder within Windows
Explorer. Selecting this option will launch Bulk Rename Utility, and will
automatically select the folder you right-clicked (or the parent folder, if you
right-clicked a file). This provides quick access to the utility.
If you are using the Favourites facility, and you have selected the option to
automatically save Favourites upon exit, then please be aware that the folder
name stored against the favourite will become the folder you right-clicked.
For reasons of performance, if you use the Bulk Rename Here right-click
function then the Sub-folders flag will be unticked, regardless of its stored
setting. This is to prevent situations where you choose a high-level folder (e.g.
C:\) without realising that a recursive directory search is about to be performed.
The note regarding Favourites above also applies here.

Doing It Manually
If you wish to enable or disable the Bulk Rename Here helper manually, it's
easy to do. Assuming you installed Bulk Rename Utility into C:\Program
Files\Bulk Rename Utility then you need to get a command line (Start, Run,
cmd) and enter the following:
regsvr32 "C:\Program Files\Bulk Rename Utility\BRUHere.dll"

You can remove the helper in a similar way:
regsvr32 /u "C:\Program Files\Bulk Rename Utility\BRUHere.dll"

Custom Date Formats

Top Previous Next

You can append a variety of dates to the filenames, either at the beginning or the
end. For example, you could prefix the filenames with their Modified date, or
you could suffix them with the Creation date.
A new feature, introduced in version 2.0.4.8, is the ability to add date and time
information in a very flexible manner, using standard formatting codes. The full
list of codes is defined below. So for example, if you wanted to suffix the
filename with the day name and the month you could enter a custom code of
"%a%M".
The full list of codes is:

Code

Meaning

%a
%A
%b
%B
%d
%H
%I
%j
%m
%M
%p
%S
%U

%y
%Y
%z

Abbreviated weekday name
Full Weekday name
Abbreviated month name
Full month name
Day of Month (01-31)
Hour in 24-hour format (00-23)
Hour in 12-hour format (01-12)
Day of Year (01-366)
Month number (01-12)
Minute (00-59)
AM/PM Indicator
Seconds (00-59)
Week number of year (00-53), with Sunday as the first day of the
week.
Weekday (0-6), with Sunday=0.
Week number of year (00-53), with Monday as the first day of the
week.
Year, with no century indicator (00-99)
Year, with century indicator (e.g. 2004)
Time zone name

%%

Percentage sign

%w
%W

You can enter other text in the filename, and the symbols above will be
substituted with the values. So, you could enter a custom value of "Created on
%a, %d %B, %Y" to get "Created on Tuesday, 25th March, 2004"

Recursive Scans (processing sub-folders)
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It is possible to perform a recursive scan and rename from the current folder.
This allows you to rename folders and files contained within any subdirectories
from the current folder. Subdirectories of subdirectories are also scanned, right
down to the lowest level.
This option needs to be treated with great care - if you scan a high-level folder
such as C:\ or C:\Program Files then the program could have tens of thousands
of files to scan. Whilst the system should cope with in excess of 250,000 files,
you will go mad waiting for the screen to be displayed!
As such, it is recommended that you only use the Subfolders selection flag flag
if you really need it.
Please note that, if you rename a folder whilst using the recursive option, after
the rename is complete the file list will be refreshed automatically. This is to
prevent problems whereby the file-list becomes out of synchronisation with the
files on your hard drive. If you don't rename a folder (just files), or if you
rename anything whilst not using the recursive option, then no refresh is
necessary.

Quick Rename via F2
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If you want to quickly rename a file/folder manually, without applying any
criteria, then you can press F2 on the filename and edit it manually. Simply
press the enter key without making any changes to cancel the operation.
If you rename a folder, and you are in recursive mode, then the file list will be
rebuilt.

Support
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If you have any comments or suggestions about the application, or find any
errors in the application, then please get in touch. The latest version of the
application can always be downloaded from the website. If you aren't using the
latest version then please upgrade before getting in touch, as your specific issue
might already be addressed in the latest release.
Remember, the easiest way to find your way around the application is to
experiment. You won't do any harm unless you hit the Rename button, so you
can play around with as many settings as you like!
The application's homepage is at www.bulkrenameutility.co.uk.

The Support forums are available at the same website.
If you get in touch with a problem then please email the following details:
· Your version of Windows (e.g. 98SE, XP Home, Vista Ultimate, Windows 7,
Windows Server, etc.)
· The version of the utility (found at Help -> About)
· How to recreate the problem. The more details you can include, the better
chance I have of finding the problem.
Please use the support forums in the first instance - they have good search
facilities and will be your quickest source of information.
Please don't send large screen prints unless requested - small screen prints are
fine.

